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Today's Learning Goals

Familiarity with R's basic syntax.
Familiarity with major R data structures.
Understand the basics of using functions.

Be able to use R to read comma-separated value
(csv) formatted files ready for subsequent analysis.

Appreciate how you can use R scripts to aid with
reproducibllity.






What is R?

R is a freely distributed and widely
used programing language and
environment for statistical computing,
data analysis and graphics.

R provides an unparalleled interactive
environment for data analysis.

3.2.2 (2015-08-14) -- "Fire Safety"

R version 3.2.
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwin13.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.

[ ] | [ [ ]
| Type 'license()' or 'licence()' for distribution details.
I S S C r | p a S e l. e I r | Ve I I y Natural language support but running in an English locale
R is a collaborative project with many contributors.
ibutors()' for more information and

computer code) and not GUl-based [FZmrm==reee
(point and click with menus). '



CRAN
Mirrors
What's new?
Task Views
Search

About R
R Homepage
The R Journal

Software

R Sources
R Binaries
Packages
Other

Documentation
Manuals

FAQs
Contributed

cran.r-project.org/index.html

Download and Install R

Precompiled binary distributions of the base system and contributed packages,
Windows and Mac users most likely want one of these versions of R:

e Download R for Linux
e Download R for (Mac) OS X
e Download R for Windows

R is part of many Linux distributions, you should check with your Linux package
management system in addition to the link above.

Source Code for all Platforms

Windows and Mac users most likely want to download the precompiled binaries
listed in the upper box, not the source code. The sources have to be compiled
before you can use them. If you do not know what this means, you probably do
not want to do it!

e The latest release (2018-07-02, Feather Spray) R-3.5.1 .tar.gz, read what's
new in the latest version.

e Sources of R alpha and beta releases (daily snapshots, created only in time
periods before a planned release).

e Daily snapshots of current patched and development versions are available
here. Please read about new features and bug fixes before filing
corresponding feature requests or bug reports.



http://cran.r-project.org

pico:sandbox> R

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute 1t under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

>




pico:sandbox> R — .
\ ype "R” In your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute 1t under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

>




pico:sandbox> R — .
\ ype "R” In your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute 1t under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type 'q()' to quit R.

> This is the R prompt




pico:sandbox> R — .
\ ype "R” In your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY. |
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.

Type |'q()' to quit RJ

> This is the R prompt: Type ¢() to quit!




What R is NOT

A performance optimized software library for
incorporation into your own C/C++ etc. programs.

A molecular graphics program with a slick GUI.
Backed by a commercial guarantee or license.

Microsoft Excel!



What about Excel?

Data manipulation is easy
Can see what is happening
But: graphics are poor
Looping is hard

Limited statistical capabilities

Inflexible and irreproducible  Use the right tool!

There are many many things Excel just cannot do!



| Christie Bahlai
Weekly plug for scripted analyses:

Coauthor: "Can you change x,y,z about the analysis?”

Me [not crying]: "Yes." [changes 2 lines of code]
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Rule of thumb: Every analysis you do on a dataset
will have to be redone 10-15 times before publication.
Plan accordingly!



Why use R?

Productivity
Flexibility
Designed for data analysis



R is designed specifically
for data analysis

* Large friendly user and developer community.

* As of Jan 6th 2019 there are 13,645 add on
R packages on CRAN and 1,649 on
Bioconductor - much more on these later!

* Virtually every statistical technigue is either

already built into R, or available as a free
package.

* Unparalleled data analysis environment for
high-throughput genomic data.



Modularity

Core R functions are modular and work
well with others

Interactivity

R offers an unparalleled exploratory
data analysis environment

Access to existing tools and cutting-

Infrastructure edge statistical and graphical methods
Subport Extensive documentation and tutorials
PP available online for R
R Philosophy Encourages open standards and

reproducibility



Modularity

Core R functions are modular and work
well with others

Interactivity

R offers an unparalleled exploratory
data analysis environment
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Infrastructure edge statistical and graphical methods
Subport Extensive documentation and tutorials
PP available online for R
R Philosophy Encourages open standards and

reproducibility



Modaularity

R was designed to allow users to interactively build complex
workflows by interfacing smaller ‘modular’ functions
together.

An alternative approach is to write a single complex
program that takes raw data as input, and after hours of

data processing, outputs publication figures and a final
table of results.




Which would you prefer and why?

Modular
VS

Custom




Advantages/Disadvantages

The 'monster approach’ is customized to a particular project
but results in massive, fragile and difficult to modity (therefore
inflexible, untransferable, and error prone) code.

With modular workflows, it's easier to:

e Spot errors and figure out where they're occurring by
inspecting intermediate results.

e Experiment with alternative methods by swapping out
components.

* [ackle novel problems by remixing existing modular
tools.



'Scripting’ approach

Another common approach to bioinformatics data analysis
s to write individual scripts in Perl/ Python/Awk/C etc. to
carry out each subsequent step of an analysis

N v 4 e w
. GRS
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This can offer many advantages but can be challenging to
make robustly modular and interactive.




Interactivity & exploratory data analysis

Learning R will give you the freedom to explore and
experiment with your data.

"Data analysis, like experimentation, must be considered as
a highly interactive, iterative process, whose actual steps
are selected segments of a stubbily branching, tree-like
pattern of possible actions”. [J. W. Tukey|



Interactivity & exploratory data analysis

Learning R will give you the freedom to explore and
experiment with your data.

"Data analysis, like experimentation, must be considered as
a highly interactive, iterative process, whose actual steps
are selected segments of a stubbily branching, tree-like
pattern of possible actions”. [J. W. Tukey|

Bioinformatics data is intrinsically high dimensional and
frequently ‘'messy’ requiring exploratory data analysis to
find patterns - both those that indicate interesting biological
signals or suggest potential problems.
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R Features = functions()
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How do we use R?



Two main ways to use R

4, sandbox (R)
pico:sandbox> R

R version 3.2.2 (2015-08-14) -- "Fire Safety" 2 ‘
Copyright (C) 2015 The R Foundation for Statistical Computing ¢ summary (dfamonds
Platform: x86_64-apple-darwinl3.4.0 (64-bit) © summary(dasonds pr ic ,

:[1- Code Editor] |3 WWorkspace and
— History

Tées Plots Pakages  Melp

). 7979

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

7 oom » Lpots Q

Natural language support but running in an English locale

Diamond Pricing

R is a collaborative project with many contributors. 15¢ u. ; : a7 i >
Type 'contributors()' for more information and "
'citation()' on how to cite R or R packages in publications. 1,800 4 PIOt and files

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

> 1

1. Terminal



We will use RStudio today

View Project Wodapace Piots

formatMoL R

of 10 variables
summary (diamonds

summary (diamonds Sprice

avessze

N 3- Workspace and
History

Tdes Plots  Padages Melp

>m » Lpots Q

Diamond Pricing




|_ets get started...

Project Wordopace Piots Took  Melp

formatiuoL R

View damonds

summary (diamonds

mary (diasondsiprice

3- Workspace and
History

fdes Plots  Padages Melp

com & Liponte Q

Diamond Pricing




Tools > Global Options

 We will NOT save our workspace...

Options

Default working directory (when not in a project):

General
Browse...

Code

v|Re-use idle sessions for project links
.' Appearance v Restore most recently opened project at startup

v Restore previously open source documents at startup
Pane Layout

Restore .RData into workspace at startup

Packages Save workspace to .RData on exit:

R Markdown v/ Always save history (even when not saving .RData)

Y7 Remove duplicate entries in history
@/~ Sweave

B Show .Last.value in environment listing
v

Spelling
v Use debug error handler only when my code contains errors

~~ .
¥ Git/SVN Automatically expand tracebacks in error inspector

7~ L
& Publishing Wrap around when navigating to previous/next tab

- Terminal v Automatically notify me of updates to RStudio




Tools > Global Options

Optional] Change to dark Appearance and
ncrease font size, etc.

Options

RStudio theme:
General Modern

plot <- function (x, y, ...
Code Zoom: {

- 125% % if (is.function(x) &&
Editor font: is.nullCattr(x, "clasj
) Monaco {

Editor font size: if (miSSing(y))
Packages 13 y <- NULL

Pane Layout

Editor theme:
Ambiance

Chaos hasylab <- function(...

@~ sweave Chrome ' .
Clouds lall(is.na(

_Clouds,Midnight | pmatch(names(list(.
Cobalt | "ylab")))

- "Crimson Editor
& Git/SVN Dawn

Dracula if (hGS)’lCIb( Soc ))
& Publishing Dreamweaver plot.function(x, vy, .

Eclipse

- ) Idle Fingers
Terminal Katzenmilch else

Kr Theme .
Material plot .function(

Merbivore X , y ,
Add... ylab = paste(
deparse(substitute

00",

R Markdown

ABC

v~ Spelling




_ets get started...

-t & # Go to file/function E% - Addins - £ tmp -
Console  Terminal Jobs =) Environment  History  Connections — ]
~/Desktop/test/tmp/ = .~ & M [ ImportDataset - =Lst- C -

i Global Environment - (o}

R version 3.6.0 (2019-04-26) -- "Planting of a Tree"
Copyright (C) 2019 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl5.6.0 (64-bit) Environment is empty

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.

Type 'license()' or 'licence()' for distribution details. R et W =0
+4 New Folder = %J] Delete [y Rename ¥ More - (C
Natural language support but running in an English locale 8a H°:";>De5kt°p 2 test > tmp - @ -
ame 1ze
1
R is a collaborative project with many contributors. 8 © tmpRoroj o3

Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type "qQ)" to quit R ___

. "Console" !




Some simple R commands

/ R prompt, don't type this!

1) (>])2+2
[[1 4]F{esult of the
command
2 > 372
[1] 9
3 > sqgrt(25)
[1] 5
4 > 2*(1+1)
(1] 4
+ Order of
0 >[2 1+1]prec:edence
[1] 3

6 ~ exp(l)

[1] 2.718282

/7 > log (2.7
(1] 1

18282)

8 =~ log(lO,[ basezlo)]

(171 1
9 > log(l

-r\b
> x=1:50

> plot (x,

Optional
argument

ase =
Incomplete commant

sin (x) )



Does your plot ook like this?




plot(x, sin(x), typ="I", col="blue", Iwd=3, xlab="x = 1:50")

Options:  7plot ?plot.default
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Key point: You need to visualize your data!
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crror Messages

Sometimes the commands you enter will generate errors.
Common beginner examples include:

* Incomplete brackets or quotes e.g.

((4+8)"20 <enter>

_|_

This eturns a + here, which means you need to enter the remaining
bracket - R is waiting for you to finish your input.

Press <ESC> to abandon this line if you don't want to fix it.

* Not separating arguments by commas e.g.
plot(1:10 col="red”)

e Typos including miss-spelling functions and using wrong type of brackets
e.g.
exp{4}



Your turn!

https://bioboot.github.io/bimm143_W20/class-material/04_rintro/

It you have done the introductory DataCamp course
then feel free to jump to section #3 Object Assignment


https://bioboot.github.io/bimm143_W20/class-material/04_rintro/

Topics Covered.

Calling Functions
Getting help in R
Vectors and vectorization
Workspace and working directory
RStudio projects
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Vectors

e \/ectors are the most basic data structure in R

* All elements of a vector must be the same type

 When you attempt to combine different types they will
be coerced to the most flexible type.




Names

 YOu can name a vector in several ways:

 When creating it: _

* By moditying an existing vector in place:

e You can then use the names to access a subset
of vector elements:




Why is this useful”?

e Because if you know the name (i.e. your label)
then you don't have to remember which element
of a vector the data you are after was stored in.
Consider this fictional example:




R has many aata
Structures

These include:
e vector
e data frame
o st
® matrix
® factors




data.frame

e data.frame is the de facto data structure for
most tabular data and what we use for statistics
and plotting with ggplot2 - more on this later!

* Arguably the most important R data structure

 Data frames can have additional attributes such
as rownames() and colnames(), which can be
useful for annotating data, with things like
subject_id or sample_iad



data.frame continued. N

e Created with the function data.frame()

* Or more commonly when reading delimited files

(7.e. importing data) with the -

‘unctions

read.csv(), read.table(), read_xlsx() etc...

R Studio can do this for you vi

d.

File > Import Dataset > From CSV...



Useful data.frame Functions

head() -and tail() shows first 6 rows and last 6 rows
respectively

dim() - returns the dimensions (i.e. number of rows and
columns)

nrow() and ncol() returns the number of rows and
columns separately.

rownames() and colnames()- shows the names attribute
for rows and columns

str() - returns the structure including name, type and
preview of data in each column



Key Points

 R's basic data types are logical, character,
numeric, integer and complex.

e R's basic data structures include vectors, lists,
data frames, matrices and factors.

 Objects may have attributes, such as name,
dimension, and class.
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Side-note: Use the code
editor for R scripts

@ RStudio MzEH Edit Code View Plots Session Build Debug Profile Tools Window Help

‘ ew iIe » R Script 8N ~/Desktop/test/tmp - RStudio
+h .| &3 ew Project... -
4 <. . R Notebook
_ Open File... #0
2 Untitled1 Reopen with Encoding... R Markdown... = ]

IR Bl Recent Files > Shiny Web App... B Run & > Source - =
Plumber API...
1 Open Project...

Open Project in New Session... Text File
Recent Projects > C++ File

Python Script
Import Dataset > SQL Script

Save %S Stan File
Save As... D3 Script

Save with Encoding... R Sweave

Save All R HTML
R Presentation
R Documentation

Knit Document
Compile Report...

Publish...

"Code Editor

Print...

Close n
Close All

1:1 j¢ Close Project —
it Session...
(o 1 [y Quit Session —

~/Desktop/test/tmp/ # &
R is a collaborative project with many contributors.

Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

> X <-

3TO O 3 & W Wed544PM Q =
£ tmp -
Environment  History  Connections |
& = & ImportDataset - ¢ =Lst- C-
#, Global Environment ~ aQ

Environment is empty

Files Plots Packages Help Viewer — (=
%8| New Folder | xJ] Delete [y Rename %3 More - Cc
@ A Home > Desktop > test > tmp (R}
4 Name Size Modified
t.
® B tmp.Rproj 205 B Jan 15, 2




R scripts

A simple text file with your R commands (e.g. lecture04.r)
that contains your R code for one complete analysis

Scientific method: complete record of your analysis

Reproducible: rerunning your code is easy for you or
someone else

In RStudio, select code and type <ctrl+enter> to run the
code in the R console

Key point: Save your R script!




Side-note: RStudio shortcuts

371 lecture.r* | faithful

(] Source on Save Q - - = Source
. > 3

1 view(faithful)
2 plot(faithful)
3

Sends current line or
selection to console (faster
to type:

command/ctrl+enter ) Sends entire

file to console

Other RStudio shortcuts! Re-send the lines of
Up/Down arrows (recall cmds) code you last ran to the
Ctrl + 2 (move cursor to console) console
Ctrl +1 (move cursor to editor) (useful after edits)




Rscript: Third way to use R

pico:sandbox> R : e =
R version 3.2.2 (2015-08-14) -- "Fire Safety" - - ., 40 obs. of 10 varfat
Copyright (C) 2015 The R Foundation for Statistical Computing summary (413 _ —
Platform: x86_64-apple-darwin13.4.0 (64-bit) . sspeice) ; > o
R is free software and comes with ABSOLUTELY NO WARRANTY. .4 1- Code Editor C
You are welcome to redistribute it under certain conditions. \r—rep——— \P*|Sl()ry J
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale &g

Consote Diamond Pricing

R is a collaborative project with many contributors. 150 qu. ! 4700 15t qu.: 6720 1st qw.! 2,90 p y
Type 'contributors()' for more information and v SV 339 ’
'citation()' on how to cite R or R packages in publications. va. | D e \ -
Type 'demo()' for some demos, 'help()' for on-line help, or etz '  f‘, oadsscar :
'help.start()' for an HTML browser interface to help. tlcarat, pric o

Type 'q()' to quit R.

A |

1. Termina

From the command line!
> Rscript --vanilla my_analysis.R
# or within R: source("my_analysis.R"



R workspaces

When you close RStudio, SAVE YOUR .R SCRIPT

You can also save data and variables in an R workspace, but
this is generally not recommended

Exception: working with an enormous dataset

Better to start with a clean, empty workspace so that past
analyses don't interfere with current analyses

rm(list = Is()) clears out your workspace or broom icon

You should be able to reproduce everything from your R script,
SO save your R script, don't save your workspace!




R workspaces

Set Tools > Global Options

Options

General
Code
-' Appearance

Pane Layout

Packages

R Markdown

@/~ Sweave

ABC
v

Spelling

W cGit/swN

'C:J' Publishing

- Terminal

Default working directory (when not in a project):

~/tmpwork/play

v/ Re-use idle sessions for project links

v|Restore most recently opened project at startup
v Restore previously open source documents at startup

Restore .RData into workspace at startup
Save workspace to .RData on exit:

v Always save history (even when not saving .RData)

Remove duplicate entries in history

Show .Last.value in environment listing

v Use debug error handler only when my code contains errors

Automatically expand tracebacks in error inspector
Wrap around when navigating to previous/next tab

v Automatically notify me of updates to RStudio

Browse...



RStudio Projects

« We will use a new RStudio project for each new class going
forward.

File > New Project > New Directory > New Project...

* These projects will help keep us organized and divide our
work into multiple contexts, each with their own working
directory, workspace, history, and source documents.


https://docs.google.com/forms/d/1rY_8FywA2uoKBHz3k2XVdpbubWCBuH6x0Za6IGm0jsY/edit#responses

| earning Resources

TryR. An excellent interactive online R tutorial for beginners,
< http://tryr.codeschool.com/ >

RStudio. A well designed reference card for RStudio.
< https://help.qgithub.com/categories/bootcamp/ >

DataCamp. Online tutorials using R in your browser.
< https://www.datacamp.com/ >

R for Data Science. A new O'Reilly book that will teach you
how to do data science with R, by Garrett Grolemund and
Hadley Wickham.

< http://r4ds.had.co.nz/ >



http://tryr.codeschool.com/
http://www.rstudio.com/wp-content/uploads/2016/01/rstudio-IDE-cheatsheet.pdf
https://www.datacamp.com/
http://r4ds.had.co.nz/
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TryR. An excellent interactive online R tutorial for beginners,
< http://tryr.codeschool.com/ >

RStudio. A well designed reference card for RStudio.
< https://help.qgithub.com/categories/bootcamp/ >

DataCamp. Online tutorials using R in your browser.
< https://www.datacamp.com/ >

R for Data Science. A new O'Reilly book that will teach you
how to do data science with R, by Garrett Grolemund and
Hadley Wickham.

< http://r4ds.had.co.nz/ >



http://tryr.codeschool.com/
http://www.rstudio.com/wp-content/uploads/2016/01/rstudio-IDE-cheatsheet.pdf
https://www.datacamp.com/
http://r4ds.had.co.nz/

< https://www.datacamp.com/ >

J Learn R, Python & Data Scie

< C' @ Secure https://www.datacamp.com/home

DataCamp Learn v Groups

|;| You have a new assignment: »
~  Conditionals and Con...
Your Latest Activity 16 days ago

- | You have a new assignment:

Introduction to Spark inR usin " Working with the RSt...

16 days ago

| You have a new assignment:

" Introductionto R
16 days ago
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Final Knowledge Check!

What is R and why should we use it?
Familiarity with R’s basic syntax.

* Familiarity with major R data structures namely vectors and
data.frames (with more on lists and matrices next day).

* Understand the basics of using functions (arguments,
vectorizion and re-cycling).

* Be able to use R to read and parse comma-separated (.csv)
formatted files ready for subsequent analysis.

* Appreciate how you can use R scripts to aid with reproducibillity.



Reference Slides;



http://swcarpentry.github.io/r-novice-inflammation/

Sections: 1, 11 & 12 only!


http://swcarpentry.github.io/r-novice-inflammation/

Optional Exercise

Use R to do the following. Create a new script to save
your work and code up the following four equations:

1+2(3 +4)
IN(43+32+1)

J(4+3)2+1)

142 \°
(3+4)




Help from within R

* Getting help for a function

> help ("log")

> 7?2109

* Searching across packages
> help.search ("logarithm")

* Finding all functions of a particular type
> apropos ("log")

[7] M"as.logical" "as.logical.factor" "dlogis" "is.logical"
[13] "log" "logloﬂ "loglpﬂ "log2" "logLik" "logb"

[19] "logical" "loglin" "plogis" "print.logLik" "glogis" "rlogis"

* ....Oruse google
(e.g. "r log function") to find online docs



R: Logarithms and Exponentials v

log {base} R Documentation

Logarithms and Exponentials

pescription | \What the function does in general terms

log computes logarithms, by default natural logarithms, 10g10 computes common (i.e., base
10) logarithms, and 1og2 computes binary (i.e., base 2) logarithms. The general form log (x,
base) computes logarithms with base base.

loglp (x) computes log(1+x) accurately also for x| << 1 (and less accurately when x is
approximately -1).

exp computes the exponential function.

expml (x) computes exp(x) - 1 accurately also for |x| << 1.

usage | HOW t0 use the function

log(x, base = exp(l))
logb(x, base = exp(l))
logl0 (x)
log2 (x)

loglp (x)

exp (x)
expml (x)

arguments | \What does the function need

x a numeric or complex vector.

base a positive or complex number: the base with respect to which logarithms are computed.
Defaults to e=exp (1) .

Details

All except 1ogb are generic functions: methods can be defined for them individually or via the
Math group generic.

logl0 and log2 are only convenience wrappers, but logs to bases 10 and 2 (whether
computed via 1og or the wrappers) will be computed more efficiently and accurately where
supported by the OS. Methods can be set for them individually (and otherwise methods for 1og
will be used).

logb is a wrapper for Log for compatibility with S. If (S3 or S4) methods are set for 1og they
will be dispatched. Do not set S4 methods on 1ogb itself.

All except 1og are primitive functions.

[ | I O g
R: Logarithms and Exponentials v

value | \What does the function return

A vector of the same length as x containing the transformed values. 1og (0) gives -Inf, and
log (x) for negative values of x is NaN. exp (-Inf) is 0.

For complex inputs to the log functions, the value is a complex number with imaginary part in
the range [-pi, pi]: which end of the range is used might be platform-specific.

S4 methods

exp, expml, log, 1logl0, 1log2 and loglp are S4 generic and are members of the Math
group generic.

Note that this means that the S4 generic for 1og has a signature with only one argument, x,
but that base can be passed to methods (but will not be used for method selection). On the
other hand, if you only set a method for the Math group generic then base argument of 1og
will be ignored for your class.

Source

loglp and expml may be taken from the operating system, but if not available there are
based on the Fortran subroutine dinrel by W. Fullerton of Los Alamos Scientific Laboratory
(see http://www_netlib.org/slatec/fnlib/dInrel.f and (for small x) a single Newton step for the
solution of loglp (v) = x respectively.

References

Becker, R. A., Chambers, J. M. and Wilks, A. R. (1988) The New S Language. Wadsworth &
Brooks/Cole. (for 1og, 1og10 and exp.)

Chambers, J. M. (1998) Programming with Data. A Guide to the S Language. Springer. (for
logb.)

see Also | Discover other related functions

Trig, sqrt, Arithmetic.

Examples | Sample code showing how it works

log (exp(3))
loglO(1le7) # = 7

X <- 10"=-(1+2%1:9)
cbind(x, log(l+x), loglp(x), exp(x)-1, expml (x))
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